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Regards

For further Information please do not hesitate to contact us @ 3533827 and
3530890

The attached Manual IS Intended as a gUide to the use of the network, as well
as a bnef Introduction to the basIc office automation and collaboration
applications

AOJS OffIce LAN

~I~ SYSTEMS RESEARCH EGYPT
~ 0/.. Systems Engmeers and Integrators

AOJS Staff
Dalla Anan, Advanced Technology Officer
Ahmad Salem, Senior Network Engineer
Systems Research Egypt
Thursday, 07 August, 1997Date

SubJect

To
From

ThiS IS to Inform you that the AOJS office LAN IS now operational, all features
and faCIlities presented to you dunng the tralnrng session are available
However some features of the anginal design are stili not Implemented due to
missing hardware and software components These will be Installed as soon
as they arrive
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AOJS OFFICE NETWORK GUIDE

The main objective of this document IS to acquaint users with the functionality

as well as the standards and conventions avaIlable on the AOJS office LAN

The gUide describes the office layout, the various workgroups constituting the

office, the Implementation of the network and the different tools and packages

Installed on every computer It assumes knowledge of Wlndows95 and other

personal prodUCtIVity tools The AOJS office LAN IS designed to provide the

AOJS professional and administrative staff with an Integrated, highly efficient

work environment
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NETWORK COMMUNITY

The LAN at AOJS serves the project staff which IS divided Into SIX

workgroups A workgroup IS defined as a number of co-workers whose duties
and functions are closely related and Interdependent At AOJS the following
groups are Identified

Chief Of Party (COP)
This workgroup provides project leadership, mOnltonng and control function In
the project It IS made up of the following personnel

• Judge Ronald Taylor
• MOnltonng &Evaluation Officer (T80)

The Court Administration Workgroup
This workgroup provides court administration expertise and undertakes all
procedural re-englneenng activities It hosts all the vIsiting short-term
consultants In this area It IS made up of the following personnel

• Court Administration Expert - Mr AI Szahl
• Legal Expert - Ms Shamsnoor Abdel AZlz

The Court Automation Workgroup
This workgroup provides court automatIon expertise, and undertakes all
systems development and Implementation management activities It IS made
up of the following personnel

• Court Automation Expert - Mr Walter Kuencer
• SRE Representative - Mr Shenf Hosnl, SRE President

MOJ Coordinator
This group provides coordination with the MInistry of Justice It IS made up of
the follOWIng personnel

• MOJ Coordinator - Judge Ashraf Kamal

The Judicial Training Workgroup
This workgroup provides Judicial training expertise and IS mainly responsible
for NCJS strengthening activities It IS made up of the following personnel

• Judicial Training Expert - Ms Virginia Leavitt
• Training Expert - Mr Sameer Sultan

The Project Office Workgroup
This group provides administratIve support and financial control for the
project It IS also responsible for all procurement activities It IS made up of
the following personnel

• Project Administrator - Ms Janie Abel AZlz
• Accountant - Mr Gamal Kamel
• Translator - Ms Nadia Shaheen
• Receptionist - Ms Mona Rashwan
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The following IS a schematic diagram of the physical layout of the office
space
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Fig 1 Office Layout
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NETWORK OVERVIEW

The network at AOJS IS an Ethernet star topology It consists of a Compaq
Prollant 2500 server running under Microsoft NT Server v 4 connected to It
12 Windows 95 workstations where two of them can also work as NT
workstation v 4, In addition to the above, two portables are available for
mobile and remote computing A network pnnter and a network scanner are
connected to the AOJS LAN as well The current network domain at the
AOJS office IS labeled "OA" which stands for Office Automation Other
networks might be added In the future to handle other tasks such as
development, Internet access, etc

•
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o
VISItor Computer

Fig 2 Network Layout
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NT Server

Network Printer

Network Scanner

Page 6



AOJS Office Network GUide

NETWORK SERVICES

The Local Area Network at AOJS IS designed to perform Integrated office
automation services All workstations m the office have

Desktops
The standard Desktop on the AOJS LAN IS Microsoft Wmdows 95
Workstations used by bl-Iingual members of AOJS will run the bl-Ilngual
(Arabic I English) version of the same operatmg system Wmdows 95 IS
mstalled m ItS default state, With one user profile per workstation

However, because of the speCial requirements of the Automation Workgroup,
their workstations will also run Wmdows NT workstation V 4 0 m a second
partition With dual boot capability

Personal ProductiVity ApplicatIOns
All workstations have MS Office 97 sUite ThIS proVides personal productiVity
capability of word-processmg, spreadsheets, and presentations Some
Workstations also have MS Access mstalled Agam bl-llngual members of the
project have the ArabiC enabled verSion of the office sUite MS Office 97

Collaboration and Workgroup applications
The AOJS LAN proVides all staff With a strong collaboration and workgroup
applications backbone, In the form of a central e-mail faCIlity, and a workgroup
enabled Personal Information Manager (PIM) These two application proVide
the followmg services
• Internal e-mail
• Internal Bulletm Board The Microsoft Exchange could be used to post

files to a public folder For example, you may want to post sales
projections or quarterly sales reports m a Microsoft Excel workbook so
the group can qUickly view or record the latest mformatlon

• ElectroniC Forms is an easy way to distribute and collect mformatlon
electronically For example, a form can be available for anyone to order
office supplies or post mformatlon m a public folder

• Group Scheduling

Printing FaCIlity
Users on the AOJS LAN have a very fleXible printing facility provldmg, local,
workgroup and networked capabilities as follows

• Local Printing
HP 5L laser printers are attached locally to the workstations of some
members of each workgroup

• Workgroup Printing
Members of the workgroup can print on any pnnter attached to any
member of the workgroup

• Network Printing
All Members of AOJS can direct theIr pnntmg jobs to the Heavy-duty,
fast pnnter on the network

I
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Document Scannmg
A combination of a Networked Document Scanner and a powerful Optical
Character Recognition (OCR) program proVide AOJS with a fleXible and
effective document scanning facility All Long English documents can be
converted to digital files and dlstnbuted as e-mail However, Arabic
Documents can only be stored and distrIbuted as Images (no OCR)

CommUnicatIOns
The AOJS LAN proVides a comprehensive commUnications capability to all
remote workstations through a specially configured multi port modem adapter
mstalled mto the NT server When fully mstalled the AOJS LAN Will prOVide
four networked modems and three local modems for backup In case the
server IS down

Remote Access
Members of the project who are working at the courts or other locations off
site have the capability to connect to the AOJS LAN remotely and exchange
files or operate applications on the server

Internet Access
AOJS has a compound account with RITE, one of the most efficient Internet
Service PrOViders (ISP) In Cairo This account enables members of the
project to send and receive e-mail and browse the Internet

Mobile Computmg
AOJS members and VISitors can use any of the two Compaq notebook
computers These notebooks are fitted With a multimedia docking
workstations and come With their own rIgid carrying cases

VISitor FaCIlities
VISItors to AOJS who are carrying their own portables or uSing AOJS
equipment can log on the office network and use most of ItS faCIlities such as
email, Internet access and extra storage and backup
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OPERATING ENVIRONMENT

AOJS local area network IS designed to provide users with an rntegrated, easy
to use office automation environment It uses windows applications mostly
from Microsoft

Network Operatmg System - NOS
AOJS LAN IS based on Microsoft Window NT Server 40

Desktops
All workstations In the office operate under MS Windows 95 All by lingual
users are proVided With the ArabiC enabled version of the operating systems
Members of the Court automation Workgroup also have the ability to operate
under MS Wrndows NT Workstation 4 0

PERSONAL PRODUCTIVITY ApPLICATIONS

MS Office IS the standard personal productiVity tool for AOJS ThiS IS also
supplemented by other products Such as Lotus Organizer, and Norton
AntiVirus to enhance ItS capabilities

COLLABORATION AND WORKGROUP APPLICATIONS

A number of workgroup and collaboration applications are also proVided In an
effort to Simplify and streamlrne workgroup actiVities

The components of thiS environment are reviewed below rn a little more detail

I
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DESKTOPS (OPERATING SYSTEM)

Ten Workstations at the AOJS are powered by Windows 95 The remalnrng
two workstations have Windows 95 In addition to NT 4 a workstation
installation

Wm 95 workstation
The graphical user Interface of Window 95 makes uSing a PC easier and
faster than before Windows 95 provides easy Internet access, multitasking,
and long file names And no wornes about incompatibility Windows 95 not
only fully supports the latest, fastest productiVity applications and multimedia
programs, It runs most Windows 3 x and DOS programs as well

Windows 95 operating system gives the user
• Fast performance and an easy-to-use Interface
• Enhanced stability and protection
• A versatile platform for mobile computing
• The highest level of software and hardware compatibility
• A great way to get on the Internet

Norton AntiVirus
Because of pervasive problem on virus infection In large workgroup, AOJS
office LAN workstations are covered by Norton Anti Virus program It proVides
the most complete and easiest protection tool for Windows 95 users It
protects your data and your computer from almost all viruses PeriodiC
updates of thiS program Will be downloaded to all workstations at the
beginning of every month

NT v 4 0 workstation
Windows NT workstation proVides powerful performance and reliability It
enhances productivity and reduces computing costs It IS easy to use, offering
the look and feel of Windows 95 The updated Interface enhances usability
and effiCiency, and Includes the familiar Windows 95 Start menu, Explorer,
wizards, and Interactive Help NT workstation proVides effiCient management
It Includes remote management and troubleshooting tools for effiCient
management and administration It embodies a performance monrtor and
event monrtor for local and remote troubleshooting

I
I
I
I
I
I
I
I
I
I
I
I
I 07/08/97 Systems Research Egypt Page 10



AOJS Office Network GUIde

PERSONAL PRODUCTIVITY ApPLICATIONS

MS Office 97 (English I Arabic) contains the following

Microsoft Excel Breaks down the barners of tradItional spreadsheets,
making It easier than ever to analyze, report, and share your data

Microsoft PowerPomt You can easily organize, powerfully Illustrate,
and profeSSionally deliver your Ideas

Microsoft Access Provides relational database power to give you the
information you need to make better deCISions It Integrates data from
spreadsheets and other

Microsoft Outlook Provides an Integrated desktop where you can
organrze and manage your e-mail, calendar, contacts, tasks, and files
In one place

Page 11Systems Research Egypt

Microsoft Word Gives you everything you need to create
profeSSional-looking documents, communIcate your Ideas, and share
information The Innovative new tools In Word 97 make It easy to get
powerful results

Office Bmder Stores all your files for a project In one place-you can
even add common headers and footers so they look and print like one
document Very useful In creating long reports created In different
Office applications

07/08/97

Organizer 97 Lotus Organizer IS a personal information and time manager
for scheduling appointments, tracking to-do lists, maintaining address lists,
managing contacts and more Organizer 97 became somehow redundant
after the release of Outlook and Schedule+ as free components of MS
Office and MS Exchange It was ordered before that event
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COLLABORATIONS AND WORKGROUP APPLICATIONS

AOJS LAN provides members of the project office with two powerful
workgroup applications that enable them to exchange e-malls and e­
documents, also to schedule meetings and other group activities In addition to
shanng contact lists and other information

Microsoft Exchange It embraces Internet standards and extends rich
messagmg and collaboration solutions to bUSInesses It creates and manages
large mailing lists Once connected to the network at AOJS, you can send
malls to members of the same domam or on another domam, or Internet mall

Microsoft Schedule+ Makes It easier to manage calendars, tasks, and
contacts for yourself or share them within workgroups Scheduling workgroup
meetmgs IS also possible

•
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ADDITIONAL TOOLS & SPECIAL APPLICATIONS

VISIO Includes everything you need to manage and clarify business
informatIon through visuals, such as organization charts and block diagrams

ABC Flowcharter Powerful tool to draw flowcharts and diagrams

CorelWPL It IS a collection of products It IS used to convert any of AOJS
files that need to be sent to the States to the same format as the one used
over there

Microsoft Project It'S a project management solution It makes project
management a natural part of your everyday bUSiness planning So you can
plan, manage, and commUnicate better to stay on schedule and on budget

pcANYWHERE32 Gives Instantly access to data and applications from your
office computer or network, from home or on the road QUIckly transfer files
from location to locatIon or from laptop to desktop More over, you can dial
Into your home or office PC and work Just as If you were there Transfer files
from laptop to desktop Use office-based applications and edit documents on
remote machines pcANYWHERE32 Will be Installed on the two portables, In
addition to any other workstations possessing a modem

Page 13Systems Research Egypt07/08/97

Microsoft Publisher Creates effective, hIgh-Impact publIcatIons Publisher IS

exceptionally easy to use, so you can get creative nght away The program
offers so much deSign help PageWizard deSign assistants gUide you
step-by-step to help you create all kinds of projects - brochures, newsletters,

flyers, Web Sites, postcards, bUSiness cards, inVitations, greeting cards,
labels, sIgns and banners, stationery and envelopes, calendars, bUSiness
forms, speCialty Items, and much more
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MOBILE COMPUTING

The project has two notebook computers with docking stations that can be
used by members of the project or Its VIsitors They can be connected to the
network, or used as stand alone computers They can also be earned by
AOJS staff or VIsitors to pilot court locations (North Cairo and Ismailla) While
being outside the office they can remotely access the AOJS LAN uSing the
bUilt In modem and a telephone line This Will be accomplished uSIng the
pcANYWHERE32

Notebook SpecificatIOns

Item Specifications
Model Compaq Armada 4130T
Processor Pentium 133 MHz
Memory 32 MB
Display 11 8 Inch
Battery Two Batteries
Operating System Windows 95

Oth P her enp era S
Item SpeCifications

Modem/Network Card Xlrcom Credit Card Ethernet + Modem
288

Docking Station 8x CD-ROM = One Battery
Portable Printer HP 320

Custody
The custody of these notebooks all their penpherals IS with the project
administrator A Simple procedure IS used to obtain use by a member of the
project or by a VISitor ThiS procedure IS as follows
-To take a Unit

- Make sure that a Unit IS available
- Fill the appropnate form
-Test the unit to Insure It IS In good working order

-To return a Unit
- Complete Section B of the form
- Demo Unit to administrator

I
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NOTEBOOK ACQUISITION FORM

Name

Position

Purpose

Location

SECTION A

North Cairo Court 0
JIC 0

Ismalha Court
Home

o
o

Date of Borrowing
Expected Date of Return

Is the docking station taken?

Is the modem connectIon taken?

Is the Network connectIon taken?

Signature of Borrower

/ /

Signature of Project AdmIn

SECTION B
Is the modem connection brought back?

Is the modem connection In good state?
Comments

Signature of BorroWerI
I
I
I
I 07/08/97

SIgnature of Project Admin

Systems Research Egypt Page 15
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INTERNET ACCESS

AOJS uses RITE (Regional InformatIon Technology Enterprrse) as the
Internet ServIce ProVider The following are actIve e-mail addresses

aOJs@nte com
rtaylor@nte com
walter@nte com
vlrgmla@nte com
aszahl@nte com

At the present tIme access to the Internet by all members of the AOJS project
IS restrrcted due to the fact that commUnicatIon server components (multi-port
+ modem sharrng software) have not arrived yet Only workstation with a
phySical modem Installed can access the Internet

I
I
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VISITORS

AOJS office will often receive VIsitors on assIgnments Two possible patterns
have been Identified either the VIsitor does not have his own machine and will
need to use the AOJS resources or he/she has his/her own portable and
need to connect to the AOJS LAN In both cases, he/she IS entitled to use the
AOJS resources and get connected to the LAN

Office Resources
A vIsitor who IS not carrying hiS own portable can ask the Project
Administrator to be assigned the use of available computing resources
He/she may be asked to share one of the office workstations, or he/she
maybe given use of one of the office portable In either case the VISitor
should contact the system admInistrator to Issue a login name

Personal Resources
A VISitor who IS carryIng hiS own portable and other penpherals can also ask
to access the office LAN so he/she can use other resources such as
exchanging e-malls, access files and backup his/her files on the server In this
case he/she must consult With the system supervisor on the hook up
procedure (Virus check, conformance to conventions, etc )

Issue VIsitor logm name
Before the VISitor can access and use the network resources, he must be
aSSigned a user name and a unique password This IS done by the System
AdmInistrator Immediately upon arnval Returning VISitors can have their old
accounts reinstated All VISitor names Will start With the letters VISitor and hiS
last name
Ex VISitor steelman

Termmate
After the completion of the vIsitor miSSion, his/her account Will automatically
expire If any of the AOJS resources was used dunng the VISit, It should be
exammed and returned m case of portables

Frequent VISitors
In case of frequent vISitors, they Will have their accounts always up and
running as well as a default folder contalnmg all their work named after their
logm name

PriVileges
VISitors can enJoy the follOWing
Use of personal productiVity applications
Personal Mall Box
Internet Access
50 MB personal space on the Server
Automatic Backup dally

I
I
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E-maIl
If the VIsitor has an account with a servIce provIder outside Egypt, he can
check his mall by first establishing a connection with RITE, then perform a
TELNET operation on hIs own server and check his mall He can perform thIS
eIther from the portable he owns (If he owns one with a modem) or from his
assigned portable, or from any of the three machines with the modem

Back-up
All work done by any VIsItor Will be kept as a backup on the server In a
directory with the VIsitor name

07/08/97 Systems Research Egypt Page 18
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VISITOR ARRIVAL/DEPARTURE FORM

ARRIvAL

Name

Login Name

OrganIzation

Workgroup

Duration of Stay

e-mail address

OFFICE RESOURCES NEEDED

I
I
I
I
I
I
I
I
I

Workstation

Portable

Printer

OWN PORTABLE

Model

Operating System

AntiVirus Protection used

LAN Access

Backup

DEPARTURE

House Keeping Performed

Equipment Returned

Signature of Administrator

07/08/97 Systems Research Egypt

Date
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STANDARDS AND CONVENTIONS

All members of the AOJS office are represented as unique entities on the NT
network Some standards are set to easily Identify each member

• User Name (Long on name)
User name IS composed of two parts first initial and the family name It IS
used to logon to the network as soon as he/she puts the computer on This
same user name IS used to denote the computer name While uSing the MS
Exchange, the address book shows all the available user names as well as all
the previously mentioned workgroups

Page 20Systems Research Egypt

AOJS Member Name User Name
Ashraf Kamal AKamal
Gamal Kamel GKamel
Janie Abdul AZlz JAbdulazlz
Mona Rashwan MRashwan
Ronald J Taylor RTaylor
Samlr Sultan SSultan
Sherif Hosnl SHosnl
Shmasnoor Abdul AZIZ Snoor
VlrQlnla Leavitt VLeavltt
Alber Szahl ASzahl
Nadia MaQdy NMaqdy
Walter Kuencer WKuencer

07/08/97

• VISitor Names
VISitors will be assigned user names for the duration of their stay These user
names will be made inactive upon their departure However If the same
VISitor returns on another triP, his user name will be reactivated User names
will always start With the word <VISitor> to be followed by a pOint followed by
the family name of the VISitor
Ex VISitor steelman

VISitor Felsen

• Default Folder
A default folder IS created for every user on his computer, It IS created on the
C drive (the hard diSk), With his previously mentioned user name While uSing
the MS Office (MS Word, Excel, etc ), any created document should be
saved under this default folder DUring the backup procedure, thiS folder IS the
only one which will be saved on the NT server SO It'S recommended to save
all your Important data and documents under thiS folder to facilitate the
recovery procedure In case of any damage or loss
Another folder IS created on the server With the user name as well The user
IS automatically connected to thiS folder after logging In to the network The
network drive Will be the F drive

I
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SECURITY

• PC Password
This secunty IS done on the PC level Every user has to enter
password to Just access the PC

• LAN Password
Every AOJS user has a LAN password permitting him to check his
mall, to do the dally back up and to access his directory or files on the
server

i
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VIRUS PROTECTION

To overcome the spread of viruses at the AOJS office, Norton AntiVIrus for
Windows 95 IS Installed on every machine All computers are now vIrus free
and the automatic protection feature IS on The Norton AntiVIrus IS active m
the background, ItS Icon could be seen In the tool bar and It'S strictly forbidden
to close It as It should be actIve all the time If a virus IS ever found, Norton
AntiVirus will gUide the user through the process of eliminating It It's urged to
scan floppies before first use and make sure that It IS not mfected The user
can perform at hiS premises scanning of specific files, folders, or entire drives
for viruses In addition, Norton AntiVirus performs scheduled scans to run at
predetermined times The virus definItIon files contammg Information that
Norton AntiVirus uses durmg scannmg for known virus should be updated
every month ThiS definition will be downloaded from the Internet every month
and mstalled on every computer to maintain the latest version

I
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START- UP PROCEDURE

Shut Down Procedures
Windows 95 IS senSitive to the way It IS shut down If It was shut
Inappropnately a registry corruption happens and a subsequent set of
problems occurs

Planned Shut Down
The BIOS Will permIt unattended shut downs So Just click the Icon to
backup and upon completion of the backup, click Start button, and
then Shut Down You don't have to walt, Just turn off the mOnitor and
that's It

Start-Up After unplanned Shut Down
If any unplanned shut down happens, It'S recommended to start IS Safe Mode
by pressing F8 In the startup of the computer And In case of Registry
Corruption, also start In Safe mode and then shut down properly and start In
normal mode

Unplanned Shutdown
If a power failure happens, so It'S advisable to start In safe mode and
this by clicking on Fa dunng the start-up of the machine and choose
from the menu Safe Mode After logging In try to recover your
documents and restart the machine again but In the normal mode

Page 23Systems Research Egypt07/08/97

Normal Start-up
When the workstation IS powered up, a logon screen calls for the user name
and password to get connected to the LAN Getting connected and remain
connected IS essential as It permIts to use the mailing system, MS Exchange,
MS Schedule+, and perform the dally back up
At the start-up, Norton AntiVirus IS active In the background
Also, at the nght of the screen, a tool bar IS hanging for easy access to
programs
The follOWing applications Will be opened on start up
MS Exchange Client
MS Schedule +

I
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BACKUP

PERSONAL ARCHIVING

RECOVERY

Page 24Systems Research Egypt07/08/97

NETWORK BACKUP

A weekly backup IS done on the server Itself Ail the data Will be backed to a
tape drive In case of any corruption to the Initial data

IOMEGA ZIP DRIVE

Iomega Zip Dnve IS another way to copy a bulk of data ThiS dnve can
accommodate data up to 100 MB

An Icon IS created on every desktop called "Back Up" AOJS users are
advised to save all their documents under the previously mentioned folder
created on every workstation with their user name Upon mouse cltck of the
Icon, all documents under this folder will be backed up on the server
It's worth to be mentioned here, that only newly created or updated files Will
be backed up

The network dnve on the server IS "F" AOJS users Will see a folder with their
user name containing all the documents that have been backed up dally If a
certain document IS destroyed, the user can perform a simple copy and paste
from the network dnve to his/her hard disk under the default folder
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Problem Escalation Scenano

SUPPORT

Step one (RTM)
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SRE Support Specialist
Support Number IS

Email

Step Two (Resident Support Person RSP)
An AOJS Well-trained person will be designated In the AOJS offices to
provide second line support

Users are expected to be familiar with the application programs they are
uSing They would have gone through the Initial training program which would
have prepared them for their work Stili support Issues do anse We
recommend the following

SRE
SRE will provide In depth support for AOJS users and VIsitors, the procedure
for thiS IS as follows

Help Desk

The user must be aware of his actions and the changes to the environment
ThiS IS essential as he/she has to report accurately to the support specialist

SRE will provide on site assistance and support until August 30 1997 After
that date SRE will provIde telephone support from our offices In Maadl The
numbers to call are
Telephone 3533827
Fax 3530890
Mobile 0122163014
If the problem cannot be resolved through the help desk,
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SYSTEM ADMINISTRATOR SECTION

Care and feedmg of Server

• Weekly Backup
A weekly backup IS done regularly on tapes Tapes Will be kept In case any
corruption happens to the AOJS files located on the server
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• InSIght Manager
Compaq InSight Manager IS a comprehenSive management tool to monitor
and control the operation of Compaq servers and clients Compaq InSight
Manager consIsts of two components a Windows-based console application,
and server or client-based management data collection agents
Working In conjunction with the hardware and firmware, the InSight
Management Agents monttor over 1,000 management parameters Key
subsystems are Instrumented to make health, configuration, and performance
data available to the agent software The agents act upon that data, by
initiating alarms In the event of faults, and by proViding updated management
mformatlon, such as network Interface or storage subsystem performance
statistiCS With Compaq InSight Manager, you have real control over your
systems, with mOnitoring and alertmg capabilities for the Critical systems In
the enterprise

• Server ON/OFF
PowerChute provides orderly shutdown of the network file server In the event
of an extended AC power failure PowerChute prompts user notification of
approachrng shutdown, power event logging, auto-restart upon power return,
and UPS battery conservation features PowerChute shows real-time
graphical displays of transient data such as battery voltage, UPS load, utility
line voltage, run time remaining, battery capacity, and battery voltage
PowerChute consist of two mall components The first IS the UPS Monrtorlng
Module that runs as a background process It communicates with the UPS
and the User Interface Module, logs data and events, notifies users of
approachrng shutdown, and when necessary, shuts down the operating
system The second IS the User Interface Module gathers real-time data such
as UPS output, temperature, status

• UPS
A UPS IS Installed and connected to the server In case of any power failure,
the UPS works for not less than 20 minutes gIVing the server time to
shutdown uSing PowerChute After power IS on again, the UPS starts the
server agam
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WHAT'S NEW IN WINDOWS 95

GETTING STARTED WITH WINDOWS 95

Wmdows 95 has some new and Improved features that wIll help you to work more
efficIently WIth your computer Here are some changes that you should notIce
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1 LOGIN TO AOJS NETWORK

As prevIOusly mentIOned the domam at the AOJS office IS called "OA" standmg for
Office AutomatIon All AOJS members have to logm to the network the first thmg m
the mornmg after turnmg their computers on A dialog box appears With the last
logged user name on thiS machme For example Nshaheen, followed by a password
that the user has to prOVIde and the domam name ""hlch IS wntten by default "OA"
As soon as the password IS venfied by the network, the user wIll be connected to the
domam and has access to all network resources
If any user SIts on a dIfferent machme than hiS own and wants to get access to the
network, he/she WIll have to prOVide hIS logm name and hiS password on thIS
machme When the ongmal user logm the next tIme, he/she wIll h:we to wrIte hls/her
name agam mstead of the one prOVIded

• Start Menu & Taskbar The Start Menu and Taskbar have been deSIgned to
replace the Program Manager and ItS Program Groups

• Desktop The Wmdows Desktop now contams new Icons called Shortcuts
• Explorer Wmdows Explorer IS the new Improved FIle Manager WIth It,

you can get a clearer VIew of your folders and files
• Network NeIghborhood The Network NeIghborhood IS the tool to use

when you want to find a folder or file on another computer(Ifyou have the
permIssIOn to do It)

• Long FIlenames In Wmdows 95 you can name your files WIth any length
filename (,ven WIth spaces l

• Shortcuts Shortcuts are IdentIcal to Icons, except that they can be put m the
Start Menu or the Desktop

• RIght ClIckmg Most Items m Wmdows 95 can now be clIcked on With the
nght mouse button After nght clIckmg on an Item, a menu wIll appear With
optIOns pertammg to what you clIcked on

In recent years, Wmdows has become a standard m the computmg mdustry
The new GraphIcal User Interface (GUI) m Wmdows 95 has been designed to allow
users to access theIr programs and files vIsually
The GUI m Wmdows 95 IS appealmg 3-D buttons and wmdows, color Icons,
gUIde the nOVIce through the system The Start Menu IS the gUIde through all of the
programs and capabIlItIes m the Wmdows 95 envIronment
If you are already famIlIar WIth Wmdows 3 1, Wmdows 95 contams many
of the features that you have taken the tIme to learn, such as double clIckmg, clIckmg
and draggmg Other features have been Improved upon and/or renamed FIle Manager
IS now replaced by Explorer, WhICh functIOns m almost the same fashIOn
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COMPONENTS OF THE WINDOWS 95 DESKTOP

Application User GUIde

2 START WORKING WITH WINDOWS 95
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• THE START BUTTON AND TASK BAR

Is where Wmdows 95 IS centered functIOnally Usmg It, you can start, mmImIze, and
maxImIze programs The Start button and taskbar are located at the bottom of your
screen when you start Wmdows 95 By default, they are vIsIble when Wmdows IS
runnmg When you clIck the Start button, you see a menu whIch contams almost
everythmg you need to begm usmg Wmdows To sWItch between wmdows, Just clIck.
the button of the wmdow you want When you close a wmdow, ItS button dIsappears
from the taskbar

• THE RECYCLE BIN

Holds all of the files that you delete untIl decIde to empty It When the Recycle Bm IS
emptIed, the files are destroyed permanently

• THE NETWORK NEIGHBORHOOD

Is sImIlar to the My Computer Icon m that It bnngs up a wmdow m whIch you can
browse files and dlrectones However, the Network. NeIghborhood contams all of the
computers on the AOJS Network. To connect to a computer on the network., you must
know that computer's password or have permIssIon to access It

• My COMPUTER

Contams all of the dnves connected to your computer After double clIckmg on the
Icon of My Computer, you wIll see a wmdow that shows you Icons for your floppy
dnve, hard dnve, network. dnve, and any pnnters connected to your computer ThIs
wmdow also allows you to see any files and folders that are on these dIsk dnves
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• MANIPULATING WINDOWS

All programs m Wmdows 95 are run withm wmdows, or boxes that have SImIlar
propertIes

• THE START MENU

Application User GUIde
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The Start Menu on the Taskbar IS an easy and efficIent way to access your programs
and settmgs m Wmdows 95 It IS accessed by clIckmg on the Start button located on
the left hand SIde of the Taskbar After clIckmg the Start button, move the mouse
around the dIfferent menus untIl the desIred program or functIOn IS found Then clIck
once on the tItle of the program you want to launch

Programs
The Programs menu holds all of the applications that come With Windows
95 or are Installed on the computer such as Microsoft Office
Documents

The Documents menu holds Shortcuts to documents that you have
recently opened In applications
Settmgs

The Settings menu contains the Control Panel, Printers Folder, and
Taskbar optIons
Help

Help IS the familiar help program that can now also be accessed through
the Start Menu
Fmd

With thiS option, you can choose to search for files and folders on your
computer
Run

ThiS option allows you to specrfy a program to run If It does not have an
entry In the Programs menu
ShutDown

Before you turn your computer off, Windows 95 needs to save changes
and close certam files It IS very Important to use the Shut Down command
before you turn off the computer

•

•

•

•

•

•

•
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• OPENING A DOCUMENT
There are several ways to open documents m Wmdows You can open your document
from wlthm the program you used to create It Or usmg the Documents command on
the Start menu to open a document you have opened recently Also, you can use the
Fmd command on the Start menu to locate the document If you Just know ItS name or
date of creatIOn

• GETIING HELP
There are two kmds of Help Help about a speCific procedure and Help that gIves you
mformatlOn about what you see on your screen You can access Help by chckIng the
Start button and then clIck Help, you WIll find a lIst of help tOPICS You can use the
tabs In Help to search for mformatlOn In several ways For mformatIOn about an Item
In a dIalog box, clIck. the Item, and then clIck the Item -
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• Mmlffilzmg
To mmlmlze or shnnk a wmdow, chck on the first button m the nght hand
comer It has a bar symbol on It because when mInimized, a program will
appear as a button on the Taskbar

• MaXllTIlZmg
To maximize a wmdow, chck on the button with a box on It The wmdow will

then fill the entIre screen

• Restonng
To restore a wmdow to an m between Size, chck. on the button with two small

wmdows m It
• Closmg
To close a wmdow, chck on the button with the X on It If the wmdow IS a

program, cloSIng It will qUIt the program

• Movmg
To move a wmdow, chck. on the title bar and hold the mouse button down
Then drag the wmdow to where you want to pOSitIOn It

• Scrollmg
The scroll bars mdlcate that there are Items that are not currently VISible on

the screen To scroll through, move the cursor to one of the arrows and clIck.
the mouse button The mSlde of the wmdow Will move to reflect the change

mUntitled· Notepad . .
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• THE CONTROL PANEL

Application User GUide

The Control Panel allows you to change how your computer looks and operates To
open the Control Panel, choose Settmgs, Control Panel from the Start Menu The
followmg wmdow wIll appear Usmg Control Panel, you can change the way
Wmdows looks and works ClIck the Start button, and then pomt to Settmgs, then
clIck Control Panel Double clIck the DIsplay Icon to see the settmgs you can change
You can change the background color of your screen, the screen saver, the
appearance, etc
The most commonly used optlOns m the Control Panel are
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Find Fasl

Mullimedla

Adds new hardware to your system
Sets up programs and creates shortcuts
Changes date, tIme, and tIme zone InformatIon
Changes settIngs for your dIsplay
Vlews, adds and removes fonts on your computer
Changes settIngs for your mouse
Changes settmgs for your multImedia deVIces
Configures network hardware and software
Changes passwords and sets secunty optlOns
Add, removes and changes settings for pnnters
Changes how numbers, currenCIes, dates and tImes are
dIsplayed
Changes system and program sounds
PrOVIdes system mformatIOn and makes advanced
changes
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• SETIING COLORS

Wmdows provIdes several pre-defined color schemes Colors for your Wmdows
screen can be changed by chckmg on the DIsplay optlOn and choosmg the Appearance
tab

==========--------
Display 'rope,ties: - <' • - - < • • .".' •>-11f3

.:::JI

To select a new color scheme, chch. on the Schemes pull down menu After choosmg
a new scheme, the preVIew w1l1 change to show It If you want to change your colors
to the new scheme, chck the OK button If you want to change the colors of mdividual
components of a wmdow, use the Item pull down menu and then choose a new color
from the Color pull down menu

• SETIING A SCREEN SAVER

A screen saver IS a program that dIsplays movmg graphics or words on your screen
when you are not workmg In order to choose a screen saver, choose the DIsplay
optlOn from the Control Panel and then choose the Screen Saver tab

I
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-====================----
DispJilj Properties :.' -. c' - - :. .' ,,'< ,~': .'. ,-.. ' ',·:,1113

Use the Screen Saver pull down menu to choose a screen saver The example screen
wIll show you a preVIew If you want to see a full screen preVIew, use the PreVIew
button If there are settmgs that you want to change for the screen saver, use the
Settmgs button The WaIt prompt allows you to change the tIme It takes for the screen
saver to start after no work IS bemg done on the computer

• SEEING WHAT'S ON YOUR COMPUTER

Double chck My Computer Icon appeanng on your desktop A wmdows appears
dlsplaymg several pIctures, hke for example the 3 12 floppy, your hard disk, the CD
dnve and the network dnve where you back-up your work dally If you double chck
any of these Icons, you get the content of each Item
To see the hIerarchy of folders and documents, chck the Start button, pomt to
programs, and then chck Wmdows Explorer The screen you w111 get IS dlVlded mto
two partItIOn the dIsk dnves and folders appear to the left, and to the nght SIde, the
contents of the Item you chck on the left are dIsplayed In Explorer, you can browse
both the hIerarchy of folders on your computer and all the files and folders m each
selected folder Explorer IS very slml1ar to Fl1e Manager m ItS functIOnality
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• To CREATE A NEW FOLDER

For example, In WIndows Explorer, double clIck. the dIsk dnve or folder In whIch you
want to place the new folder, on file menu, POInt to New, and then clIck Folder Type
the name of the new folder, and then press Enter

To start Explorer, chck the Start Menu, and then POInt to Programs
Each Item on the left hand sIde of the Explorer WIndow represents ItS counterpart on
the Desktop The Items on the nght hand sIde of Explorer represent the contents of the
selected Item on the left Therefore, If you want to see what IS on your hard dnve,
chck on the plus sIgn besIde the entry that has C besIde It The hst wIll expand to
show all of the folders In It Chck on a folder to see ItS contents
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• To COpy A FILE TO A FLOPPY DISK

FInd the file or folder you want to copy, on the FIle menu, POInt to Send To, and then
clIck. the drIve where you want to copy the file or folder You can copy or move a file
also by draggIng In WIndows Explorer, open the folder that contaInS the file you
want to move or copy Use the rIght mouse button to drag the file to the folder where
you want to move or copy It Then release the mouse button Then clIck Move Here or
Copy Here You can also move or copy a file by draggIng It USIng the left mouse
button DraggIng a file between two folders on the same drIve moves the file
DraggIng a file between dIfferent drIves copIes It Instead

• ORGANIZING FILES AND FOLDERS

To move or copy a file or folder, find the file or folder and then clIck It, chck EdIt, to
move the file, clIck Cut and make a copy of the file, clIck copy Open the folder
where you want to place the file, clIck EdIt, and then clIck Paste To Delete a file or
folder, clIck. It and then tram File menu, chck Delete The files you delete are put In
the Recycle BIn, a holdIng place for files you no longer need They are not actually
removed from your hard dIsk untIl you "empty" the Recycle BIn
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• PRINTING
There are three types of pnntmg allowmg AOJS members to select from accordmg to
theIr needs

• Network pnntmg
Users can pnnt large documents usmg the network. prmter as long as they are
connected to the NT server In case of very large documents, users are
encouraged to pnnt on the network pnnter for fast and high qualIty output

• Local Pnntmg
Users "'Ith a laser pnnter connected to their PC Will be able to pnnt any file
locally ThIS IS recommended for short documents only Longer document s
(5 or more pages) should be pnnted on the network. pnnter
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• Workgroup pnntmg
Each workgroup IS prOVided by a lIght duty laser pnnter (HP LaserJet 5L) It
IS usually located on the desk. of the expatnate counterpart, and attached to hiS
workstatIOn Members of the same workgroup can pnnt small documents,
memos, drafts etc

• COPYING MOVING AND DELETING INFORMATION

Before edItIng any InfOrmatIOn, you must select (hIghlIght) It Place the mouse pOInter
where you want to start selectIng Then press and hold down the mouse button, and
drag the pOInter to where you want the selectIOn to end Then release the mouse
button To copy or move InfOrmatIOn, first, select the InfOrmatIOn ClIck. EdIt, to leave
the mformatIOn where It IS and take only a copy of It, clIck. Copy In the document
where you want to msert the mformatIOn, clIck the place where you want It to appear
On the EdIt menu, clIck Paste

• USING A SHARED FOLDER

Double clIck Network NeIghborhood Double chck the Icon for the computer that
contams the folder you want For example, If the file IS located on Jame's computer,
you clIck the computer named JabdulazIz Double chck the folder that contams the
document or program you want

• SHARING FOLDERS WITH OTHER COLLEAGUES

To share a folder, locate the folder or file you want to share and then clIck It On the
FIle menu, clIck Shanng, ClIck the optIOns you want Once the file IS shared, If you
take a look at It m the Wmdows Explorer, you WIll find a blue hand holdmg the folder
meanmg It'S a shared file or folder

• CREATE A SHORTCUT ON THE DESKTOP

Shortcuts prOVIde easy access to the documents or programs that you use frequently
In my Computer or Wmdows Explorer, locate the Item you want easy access to Use
the nght mouse button to drag the Item to the desktop Then release the mouse button
ClIck Create Shortcut Here
The tool bar located on every desktop at the AOJS office has shortcuts to all Office 97
components plus Wmdows Explorer, Norton AntIVirus and Lotus Orgamzer
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Steps to follow m order to pnnt In eIther case

To pnnt the document, select FIle menu Pnnt and then select from the 11st the
appropnate pnnter type accordmg to your needs

Note It should be mentlOned here that each member of the AOJS wIll have
only two optlOns of prmtmg eIther local and network, or workgroup and
network pnntmg

Page 38Systems Research Egypt07/08/97

• SHUTTING DOWN YOUR COMPUTER

To qUIt Wmdows and shut down your computer, chck the start button, and clIck Shut
Down Chck Yes and then a screen message lets you know when you can safely turn
off the computer

• MAKING YOUR WORK MOBILE

SometImes you mIght work on the same document both at home and at the office, or
use a laptop computer when you travel Now It IS easy to keep multIple verSlOns of a
file m sync wIth each other Just use Bnefcase located on your desktop
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Norton AntiVIruS IS the one of the most sophIsticated and powerful product avaIlable
to safeguard your computer from VIruS mfectlOn, no matter what the source You wIll
be protected from vIruses that spread from hard or floppy dIsks, vIruses that travel
across networks, and even vIruses that are transmItted across the Internet

• OVERVIEW OF NORTON ANTIVIRUS

Application User GUide

• To FIND VIRUSES ON YOUR COMPUTER
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-Open the Norton AntIVIrus mam wmdow If It IS not already dIsplayed
- Choose one of the followmg optIOns
o Check a dnve or dnves m the Dnves lIst box or check a category of dnves

m the Dnve Types group box and clIck Scan Now

• To INITIATE SCANS

How TO

Here's what Norton AntIVIrus does automatically

Here's what you can do wIth Norton AntiVIrus

- Scan specIfic files, folders, or entIre dnves for VIruses
- Schedule VIruS scans to run at predeternuned tImes
-Update VIruS defimtIOns files monthly
-CustomIze Norton AntIVIrus protectIon to match your nsk level of VIruS

mfectlOn

Check one ofthe followmg optIOns
- Imtiate VIruS scans at any tIme by choosmg WhICh dnves to scan and clIckmg

Scan Now m the Norton AntIVIrus (NAV) mam wmdow
- Use the Scan menu m the NAV mam wmdow to choose speCIfic files or

folders to scan
-It IS advIsed that you always scan dISks before you use them or when

downloadmg files from bulletm boards
- Schedule scans regularly
- Leave Auto-Protect enabled
-Update your VIruS defimtIOns regularly

Checks system files and boot records for vIruses at system startup
-Checks programs for vIruses at the tIme you use them
- Scans your startup dnve for vIruses once per week
-Momtors your computer for any actIvIty that mIght mdlcate the work of a

VIruS m actIOn
- Checks floppy dISks for boot Vlfuses when you use them
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The All Network. Dnves optIOn IS dimmed If you are not connected to a network or If
Norton AntIVIrus IS configured not to allow network dnve scannmg

Note If you performed a complete setup of Norton AntiVirus and accepted
all recommended optIOns, Auto-Protect scans floppies at startup and when they are
accessed What you are settmg here sImply means NAV will also always scan floppy
dnves when you ImtIate a scan

Application User GUide

• REMOVING VIRUSES
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- Repair the mfected file, boot record, or master boot record
-Delete the mfected file from the dISk and replace It WIth an umnfected copy

There are two ways to remove a VIruS from your computer

- ClIck FIle from the Scan menu
- Select the file you want to scan
-ClIck Open

• To SCAN AN INDIVIDUAL FILE

• To ALWAYS SCAN FLOPPIES (DURING SCANS YOU INITIATE)

-Open the Norton AntIVirus mam wmdow If It IS not already displayed
- Check specIfic dnves to scan m the Dnves lIst box or select multiple dnves at

once by checkmg one or more optIOns m the Dnve Types group box and clIck.
Scan Now

• To SCAN DRIVES

o The All Network Dnves optIOn IS dlInmed If you are not connected to a
network or If Norton AntIVIruS IS configured not to allow net~ork dnve
scannmg

-ClIck OptIOns m the Norton AntIVirus mam wmdow
- ClIck the Scanner tab If It IS not already on top
- ClIck Advanced at the bottom of the tab
- Check All Floppy Dnves m the Preselect At Start group box and clIck. OK to

save settmgs and eXit the dialog box
- ClIck OK to save settmgs and eXIt the dIalog box

o ClIck Folders from the Scan menu, select the folder, and chck Scan

o ClIck FIle from the Scan menu, select the file or type m a filename, and
clIck Open

o The Scan dialog box reports on the progress of the scan
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That's why all users are urged to perform the backup procedure by chckmg on the
backup Icon located on their desktops before leavmg each day
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Note that Norton AntIVIruS also scans MIcrosoft Word documents ( doc and dot)

when scannmg program files Although these are not program files, they do
contam code and can be mfected by a new class of VIruses called Macro VIruses
Therefore, some of your data files are now at nsk You need to make backup
copIes regularly

You should not leave an mfected file on your computer NAV can repair most
mfected files However, m the case that a file cannot be repaired, you must delete
It from your dIsk You need to get mto the habit of keepmg ongmal dd,s m a safe
place and makmg backup COpIes of your files If you do not have an unmfected
backup copy of a file, the ongmal program dIsk, or onlme access to the file, you
need to get a new copy of the file from the software manufacturer

-t ....._- -_~-- ,.: ~~ ~

- ...
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MICROSOFT EXCHANGE
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• SHARING INFORMATION AMONG TEAMS AND ORGANIZATIONS

• SENDING MESSAGES

GETTING STARTED WITH MICROSOFT EXCHANGE
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In addItIOn to sendmg and reCeIVIng mall, the user can access and exchange
InfOrmatIOn m publIc folders UnlIke the user maIlbox or personal folders where
he/she stores InfOrmatIOn for hIslher own pnvate use, publIc folders prOVIde an easy
and effectIve way for multIple users to collect, orgamze, and share InfOrmatIOn
Because publIc folders are centrally located on MICroSOft Exchange Server computers,
users always have access to the most up-to-date InfOrmatIOn
Pubhc folders can be desIgned and customIzed to meet speCIfic needs For example,
you mIght use a dISCUSSIOn folder to dISCUSS new Ideas

The user can send messages that mcIude formatted text, mserted files and objects, and
an AutoSIgnature In additIon, he/she can

• Address a message by selectmg names from the Address Book
• Check speIlmg before sendmg a message
• ASSIgn importance to a message (normal, hIgh, or low) and request an

automatIc delIvery notIficatIOn
• Keep the message secure by sigmng It, sealIng It, or both
• Use forms created by people m the AOJS for speCIfic types of mformatIOn,

such as a phone message or an expense report
Tips
It is recommended to use the formatted text mternally (I mean mSide AOJS) as
sendIng formatted text through the Internet falls cause the reCIpIent mIght be usmg
dIfferent maIlIng system

• OVERVIEW OF THE MICROSOFT EXCHANGE CLIENT
WIth the MIcrosoft Exchange Chent, commumcatIOn and shanng of mformatIOn wIth
other people m an effectIve and tImely manner became a reahty It enables easy
sendmg and receIvmg of malls, orgamzmg, and shanng mformatIOn, regardless of its
locatiOn or format
When the user opens the MICroSOft Exchange Chent, he/she can see the VIewer, the
wmdow to mformatIOn The left side of the Viewer dIsplays sets of folders, and the
nght side dIsplays the contents of the selected folder From the VIewer, the user can
send and receIve mall, orgamze and manage mformatIOn, and access and exchange
mformatIOn WIth other users
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• ORGANIZING AND MANAGING INFORMATION

• MANAGING INCOMING MAIL WHILE OUT OF THE OFFICE
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Folder contents IIst-

Compose Help
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Folder list

• Menu names
The menus contaIn all the MIcrosoft E'Cchange Chent commands Choose a
menu name to dIsplay Its commands
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Menu names

When the MIcrosoft Exchange Chent IS started, the VIewer IS dIsplayed The VIewer
IS your wmdow to mformatIOn the central locatIOn m the MICroSOft Exchange Chent
where you send and receIve electromc mail (e-mail), orgamze mformatIOn, and VIew
Schedule+ meetmg requests The left SIde of the VIewer dIsplays folders, and the nght
SIde dIsplays the contents of the open folder The followmg figure shows the contents
of an Inbox dIsplayed m the VIewer

• STARTING THE MICROSOFT EXCHANGE CLIENT

BASIC CONCEPTS AND FEATURES

Folders provIde the basIs for orgamzmg InfOrmatIOn The contents of any gIven folder
can range from e-maIl, SImple te'Ct files, and faxes, to documents, meetmg requests,
and forms The user can place all types of related mformatIOn In a smgle folder
regardless of where It was created There are three types of folders maIlbox folders,
personal folders, and publIc folders

If the user IS gomg to be away from the office, he/she can use the Out Of Office
AssIstant to notIfy the people who send him/her mall The Out Of Office AssIstant
sends a message to each sender only once
The user can also create rules that are performed only when the Out Of Office optIOn
IS on For example, he/she can forward a copy of each high-pnonty message that
he/she receIves to another person
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• All publIc folders
The entlre hst of pubhc folders

• Folder contents 11st
The folder contents lIst dlsplays headers of Items contamed m the open folder
Unread Items appear m bold To open an Item, double-chck 11

• PublIc folders
Folders that you and your co-workers can use to share a wlde range of
mformatlOn ThlS feature IS aVailable only wlth Mlcrosoft Exchange Server
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• Favontes
Your personal Vlew of the pubhc folder lIst You can add pubhc folders that
you frequently use to your FavorItes folder and then access them from there
mstead of lookmg through the entlre hst of pubhc folders

• Mailbox
The 10catlOn on a MIcrosoft Exchange Server computer where your mcommg
and outgomg mall IS delIvered Mall mcludes messages, forms, and other
Items Your mallbo'( contams Inbox, Outbox, Sent Items, and Deleted Items
folders You can create addltlOnal maIlbox folders to store messages and other
Items

• Folder lIst
The folder lIst IS the locatIOn where you access your mal1bo'( and folders It
mcludes the followmg Items

• Personal folders
A set of folders that you have created These folders are stored m a file that IS
typlcally located on your hard dlsk You can create a set of personal folders to
back up or archlve folders, store related messages, forms, and files, and work
wlth Items remotely You can also deslgnate a set of personal folders as the
dehvery locatIOn for your mcommg mall

• Toolbar
The toolbar provldes buttons to perform common tasks To find out what a
toolbar button does, posItlOn your pomter over the button for a moment, and a
ToolTlp wlll appear

Formattmg text by choosmg font types, font SIzes, and colors
Insertmg files and objects mto messages
Savmg caples of messages
Asslgmng hlgh or low Importance to messages

07/08/97

• SETIING OPTIONS FOR YOUR MESSAGES
When sendmg messages, the Mlcrosoft Exchange Chent provldes ) ou wlth a varIety
of optlOns The optlOns you choose can vary, and can be apphed to a speCIfic message
or to all messages Some of your optlOns are

•
•

•

•
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Complete your message WITh your A,uto51!jnalurF',

(BJt cloo

You can format your lexlln a message by
creating a bulleted list

• uSing different font types, slyltJs, and sizes
• applying colors'
You can also Insert objects and files Into your messages

-----------------------------------------------------

• LOOKING UP NAMES AND INFORMATION IN THE ADDRESS BOOK

The Address Book IS a dIrectory of address lIsts contammg user names, dIstnbutIOn
lIsts, and publIc folder names You can use the Address Booh. to address messages and
get mformatIOn, such as a phone number or Job tItle You have at least two address
lIsts m your Address Book
• A global address lIst
• A personal address book (PAB)
The global address lIst contams the names of all MIcrosoft Exchange users and
dIstnbutIOn lIsts that you can address messages to Your PAB IS a customizable
dIrectory that you create Your PAB can contam any kmd of address that you choose
to add names of people to whom you frequently send maIl, personal dIstrIbutIOn lIsts
(PDLs), or custom addresses of users of other mall systems, such as the Internet If
you work offlme, you must have a PAB

Requestmg a DelIvery or Read ReceIpt so that you know when a message
has been delIvered or opened

SIgnmg messages wIth your AutoSIgnature
Checkmg the spellmg m messages before sendmg

•

•
•
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• To SEND A MESSAGE

2 To address the message, do one of the followmg
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~ spreadsheets

tE:J documents

~ meetng requests
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3 In the Subject box, type the subject of the message
4 In the message body, type your message
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1 In the Viewer, choose New Message from the Compose menu, or chck the
New Message button

Chck To or Cc to select names from the Address Book
In the To or Cc box, type the names of the prImary reCIpIents and users whom
you want to receIve a carbon copy Separate multiple names WIth semicolons
(,)

If you want to send a message to one or more users as a bhnd carbon copy,
choose Bcc Box from the Vlew menu Then, chck Bcc to select names from
the Address Book, or type the names of the users whom you want to have
receIve a blInd carbon copy In the Bcc box

How TO

In general, It IS a good practIce to keep messages short and conCise Long "walls of
text" m marl are difficult to read and may mdicate a subject that would be better dealt
WIth eIther In a pnnted memo or In person

• FINDING INFORMATION

As you create folders and add mformatlOn to them, you may find It necessary to
search for specIfic items from tIme to tIme Usmg the Fmd command on the Tools
menu, you can easIly search for Items that meet specIfic condItIOns

• ORGANIZING INFORMATION USING FOLDERS
You can create folders In your maIlbox or In a separate set of personal folders to store
and orgamze mformatIOn The contents of any folder can range from messages, text
files, and faxes, to documents, spreadsheets, meetmg requests, and forms You can
place all types of related InfOrmatIOn In a smgle folder, regardless of where it was
created
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• To REPLY TO A MESSAGE OR TO FORWARD IT
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1 If the message IS not open, you must first select It Then, do one of the
followmg

5 From the FIle menu, choose Send, or clIck the Send button

This IS a test message I m learnlll9 how to
• Address I format and send a message
• Open a message
• Reply to a message I

-- - ---- ---- - - --- -

Note By default, all messages that you send are automatIcally saved In the
Sent Items folder

• To CLOSE AN ITEM

• From the FIle menu, choose Close

• To OPEN THE NEXT OR PREVIOUS ITEM IN THE LIST, DO ONE OF THE FOLLOWING

WHILE AN ITEM IS OPEN

• To open the next Item In the lIst, choose Next from the VIew menu
• To open the prevIous Item In the lIst, choose PrevIOus from the VIew menu

• To OPEN A MESSAGE OR OTHER ITEM IN A FOLDER

Messages that are sent to you are lIsted In your Inbox When a message sent to
you arnves In your Inbox, the header appears In bold, IndIcatIng that you
haven't read It

• Double-clIck the header of the message, or select the Item, and then choose
Open from the FIle menu
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• To INSERT FILES OR ANOTHER MESSAGE IN THE ORIGINAL MESSAGE

• To DELETE A MESSAGE OR OTHER ITEM

To reply Do thIS

Page 50Systems Research Egypt

• Internet mall It IS recommended that you type the Internet mall that need to be
sent VIa modern and Internet connectlOn to Ms Mona Rashwan In Text Format
usmg Note Pad or Word and save the document as Text

• In case of sendmg mternally Word document to any AOJS members, take mto
consIderatIOn that the bI-IIngual group has MS Office 95 and IS not able to
open MS Office 97 documents So the MS Office 97 group has to convert the
document first to the Office 95 format before pnntmg

Tips

3 From the FIle menu, choose Send, or clIck the Send button

1 ClIck the New Message button, fill the To and Subject fields From the
menu Item Insert choose eIther FIle or Message

If you are workmg m a publIc folder, you must have Delete Items PermIsSIOn to
delete an Item
From the FIle menu, choose Delete, or clIck the Delete button
If the Item IS closed, you must first select It

• To the sender only From the Compose menu, choose Reply To Sender, or
clIck the Reply To Sender button

Tips

• To the sender and everyone lIsted m the To and Cc boxes From the Compose
menu, choose Reply To All, or clIck the Reply To All button

~
• You can also forward a message to another user by chckmg the Forward

button

2 Type your reply
You can also msert comments m the ongmal message text

To delete a lIst of sequentIal Items, select the first Item In the lIst, and whIle
preSSIng SHIFT, press the down arrow key untIl you reach the last Item that you
want to delete
To delete Items In a lIst that are not sequentIal, select the first Item In the lIst, and
whIle pressIng CTRL, clIck each Item that you want to delete
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• WORKING WITH FOLDERS

• To SIGN A MESSAGE THAT YOU ARE COMPOSING

• To GET TOOLBAR BUnON INFORMATION

• To SIGN ALL MESSAGES THAT YOU SEND
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Note When you log on to the MIcrosoft Exchange ClIent WIth the Out Of
Office ASSIstant turned on, a notIce IS dIsplayed to remmd you to tum It off

<

Appltcatlon User GUide

Once you begm recelvmg messages, you'll want to organIze them so they'll be
easy to find later You can create folders and subfolders (folders withm a
folder) for orgamzmg and stonng related mformatlOn

1 From the Tools menu m the VIewer, choose Out Of Office ASSistant
2 Select I Am Currently Out Of The Office
3 In the AutoReply Only Once To Each Sender WIth the Followmg Text box,
type the message you want to send to others, for example, "Out of the office untIl
the tenth of thIS month "
4 Choose OK

1 From the VIew menu, choose Toolbar
2 When you fimsh composmg a message, clIck the SIgn button
3 ClIck the Send button
4 In the Password box, type your advanced secunty password, and then choose
OK

1 From the Tools menu, choose OptIOns, and then select the Secunty tab
2 Under OptIOns, select Add DIgItal SIgnature To Message, and then choose OK

POSItIOn your mouse pomter over the button that you want mformatIOn about
MIcrosoft Exchange displays a ToolTIp that bnefly descnbes that button

• CREATING FOLDERS

When you create a folder, It appears as a subfolder of the open folder
ClIck your mailbox

(j 1v1lcrosoft El'change
El ~ Mailbox Ann Devon

2 From the FIle menu, choose New Folder
3 Type the name of the new folder
4 Choose OK

• To SEND AN OUT OF OFFICE NOTIFICATION TO PEOPLE WHO SEND YOU MAIL

Important If you are composmg a message and set thIs optIOn usmg the Tools menu,
the optIOn wIll not be applIed to the actIve message It WIll be applIed to all future
messages
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1 Chck the Inbox to dIsplay the message you sent to yourself
2 Drag the message to the Status Reports folder, whIch you created m the prevIOUS
procedure
You can also move or copy a message by selectmg It and then choosmg Move or
Copy from the FIle menu

• MOVING MESSAGES TO OTHER FOLDERS

• EXPANDING AND COLLAPSING FOLDERS
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8 @ Mdllbox Ann Devon
~ Deleted Items
fJ Inbox
(§j Outbox
§ Sent Items
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To collapse a set of folders, clIck. the mmus SIgn (-) next to the parent folder name

Application User GUide

If you create subfolders, there wIll be times when you want to dIsplay or hIde them
To expand a set of folders, clIck the plus SIgn (+) next to the parent folder name

The eaSIest way to move messages from one folder to another IS by draggmg them

5 The Status Reports folder appears as a subfolder of the mailbox If you dId not
select the mailbox, Status Reports would have been created as a subfolder of the
open folder
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MICROSOFT SCHEDULE
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I GETTING STARTED WITH MICROSOFT SCHEDULE

I
I

• OVERVIEW OF THE MICROSOFT SCHEDULE

MIcrosoft Schedule+ IS an easy-to-use organIzer that helps keep track of schedule and
contacts MIcrosoft Schedule+ IS a tIme-management tool that allows you to manage
your schedule, tasks, and hst of contacts, and coordmate your schedule wIth others

When you start your computer, Schedule+ IS automatically activated You can also
start Schedule+ from the MIcrosoft Exchange ClIent by clIckmg the Schedule+
toolbar button m the VIewer When Schedule+ IS started, the Schedule+ wmdow IS
dIsplayed The Schedule+ wmdow mcludes a menu bar, a toolbar, a status bar, and
one of several VIews of your schedule Use the tabs on the left of the Schedule+

Schedule+ arranges mformatIOn on dIfferent tabs These tabs let the user sees hIslher
schedule, To Do lIst, contacts, and other mformatIOn m several dIfferent ways By
default, Schedule+ dIsplays the DaIly, Weekly, Monthly, Planner, To Do, and
Contacts tabs Dependmg on the detaIls the user need to know, he/she can add and
remove tabs so that Schedule+ dIsplays mformatIOn m the arrangement that works
best for hImlher

WIth Schedule+, the user can
• Track appomtments
• Schedule meetmgs wIth other MIcrosoft Exchange ClIent users
• PrIOrItIze tasks on your To Do lIst
• OrganIze busmess and personal contacts
• Set remmders to help you remember your appomtments, meetmgs, and tasks
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wmdow to sWItch between VIews Each VIew conSIsts of one or more of the folloVvmg
m VarIOUS arrangements your dally, weekly, or monthly schedule, the Planner, the
Date NavIgator, the To Do lIst, and the Contacts tab When you first open Schedule+,
a set of default tabs IS dIsplayed On the Dally tab, you can see all of the appomtments
and tasks planned for a gIven day, as shown above

Onlme Help IS aVailable m Schedule+ and IS your prImary source of mformatIOn To
get help, choose MIcrosoft Schedule+ Help TOPICS from the Help menu

• OVERVIEW OF SCHEDULING APPOINTMENTS

• OVERVIEW OF ADDING A CONTACT TO YOUR LIST

• OVERVIEW OF SCHEDULING A MEETING

When the user wants to schedule an appomtment WIth another person, he/she can use
the Meetmg WIzard The Meetmg WIzard walks you through all the steps ot
schedulIng an appomtment WIth another person and helps schedule resources for the
meetmg The user can reserve a specIfic tlme m his/her schedule to complete a task

The Contacts tab IS a convement place to enter, manage, and track busmess and
personal contacts The user can track names, addresses, phone numbers, bIrthdays,
anmversanes, and other mformatlOn for contacts m his/her hst Schedule+ dIsplays
thIS mformatIOn for each contact on a senes of tabs The user can add or change a
contact dIrectly on the Contacts tab or from withm the Contact dIalog box
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Schedule+ dIsplays appomtments on the Dally, Weekly, and Monthly tabs, and on
other tabs m your schedule When the user creates a new appomtment, Schedule+
automatIcally sets a remmder for the appomtment
The Schedule+ toolbar buttons make It easy to change an appomtment to a recurnng,
pnvate, or tentatIve appomtment lfthe user IS not sure whIch button to use, pOSItIOn
the pomter over a toolbar button and Schedule+ wIll dIsplay a toolbar tlp

Step 1 Selectmg meetmg attendees
Step 2 Checkmg the aval1abIhty of meetmg attendees
Step 3 Selectmg a meetmg tIme
Step 4 Sendmg a meetmg request
Step 5 Trackmg responses to your meetmg request

The user can schedule a meetmg, select attendees, and send them a Meetmg Request
form that mVItes them to attend
The eaSIest way to schedule a meetmg IS to use the Meetmg WIzard
The Meetmg WIzard IS the eaSIest way to schedule a meetmg The Meetmg WIzard
automatIcally walks the user through the steps of schedulmg a meetmg by ash.mg
him/her a senes of questIOns When the user fills m the answers, the Meetmg WIzard
helps him/her check for conflIcts on other people's schedules, mVIte attendees, and
even schedule resources such as meetmg rooms and computer eqUIpment However,
the user may want to schedule a meetmg on his/her own To schedule a meetmg on
his/her own, follow the steps below
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The user can gIve other Schedule+ users access perrmSSlOn to VIew or modIfy
mformatlOn m hIs/her Contacts l1st If the user desIgnates a contact as pnvate, that
contact wIll not be vIsIble to other users when they VIew hls/her 11st

How TO

• To SCHEDULE AN APPOINTMENT

• USING THE DATE NAVIGATOR

You can also chch. the Insert New Appomtment button on the toolbar

1 Select the date and tnne for the appomtment
2 In the DescnptIOn box, type a descnptIOn for the appomtment
3 Select other optlOns for the appomtment
4 Chch. OK

The Date NaVIgator IS a tool that makes It easy to move qUIckly between days and
months When you select a date, It IS surrounded by a shaded bo'C The current date
always appears WIth a border surroundmg It Days that have scheduled appomtments
or meetmgs are shown m bold
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1 Cl1ck the DaIly tab
2 In the Date NavIgator, clIck the day for the appomtment
3 HIghhght the tlme slots for the appomtment
4 Type a descnption for the appomtment
5 C11ck anywhere outsIde the appomtment

To set a remmder or make the appomtment recumng, pnvate, or tentative, cl1ck the
correspondmg toolbar button
The bell symbol mdicates that a remmder message w111 appear before the
appomtment
To schedule an appomtment and set the remmder tIme, 10catlOn, or other mformatIOn

1 Chck the Daily, Weekly, Monthly, or Planner tab
2 On the Insert menu, cl1ck Appomtment
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Application User GUide

You can also clIck the Delete button on the toolbar

• To DELETE AN APPOINTMENT
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You can start the task from the Meetmg WIzard, the Planner, or the Appomtment
dIalog box The first two methods for schedulIng a meetmg are covered below

1 ClIck the appomtment you want to delete
2 On the EdIt menu, clIck Delete Item

1 ClIck the appomtment you want to move
2 PosItIon the pomter over the top border of the appomtment
3 When the pomter becomes a four-headed arrow, drag the appomtment

to the tIme slot you want or to the date you want on the Date NavIgator
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1 ClIck the appomtment you want to move
2 On the EdIt menu, clIck Move Appt
3 Select the tIme and date you want
4 Chck. OK

• To MOVE AN APPOINTMENT TO A DIFFERENT TIME OR DATE

• SCHEDULING MEETINGS

In Schedule+, a meetmg IS an appomtment you make with other Schedule+ users
When you schedule a meetmg, you IdentIfv the attendees, determme a meetmg tIme,
mVIte the attendees, and receIve their responses You can also schedule the resources
for a meetmg, such as a conference room or overhead projector To view attendees'
schedules, they must be usmg the MIcrosoft E'Cchange Chent

Another way to move an appomtment to a different tIme or date

Usmg the Date NavIgator, you can
• Change the date that you are vIewmg by clIckmg different calendar dates
• VIew the prevIOUS or followmg month by clIckmg the left or nght arrow button

at the top of the calendar
• Move an appomtment from one date to another by selectmg It, chckmg the

border that surrounds It, and draggmg It onto the new date m the Date NaVIgator
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• USING THE PLANNER

Application User GUide

• USING THE MEETING WIZARD

The Meetmg WIzard makes It easy to set up meetmgs by promptmg you for all the
necessary mformatIOn The Meetmg WIzard walks you through

• Choosmg reqUIred and optIOnal attendees
• Choosmg a date, tIme, and locatIOn
• Choosmg any resources reqUIred, such as audIO-vIsual eqUIpment
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When the Meetmg WIzard IS fimshed, a Meetmg Request form opens, and you can
type an agenda or any other mformatIOn about the meetmg that you want attendees to
know You can also msert files or objects mto the Meetmg Request form When you
choose Send m the Meetmg Request form, all the people that you have mVIted receIve
a Meetmg Request message m the MIcrosoft Exchange Chent
• To start the Meetmg WIzard, clIck the Meetmg WIzard button on the toolbar

The Planner dIsplays your free and busy tImes over several days You can also use the
Planner to see other users' free and busy tImes When you organIze a meetmg, the
Planner shows busy tImes for users who have been mVlted, as well as busy locatIons,
so that you can eaSIly determme a satIsfactory tIme and place for the meetmg
1 Choose the Planner tab
2 Choose InvIte
3 Select the users whose schedules you want to VIew, and choose ReqUIred or

OptIOnal
4 Choose OK
The busy tImes of users who are check.ed m the Attendees hst appear as colored hnes
m the Planner To check the free and busy tImes ofJust one person, clear all other
check.s beSIde the names m the Attendees lIst
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• To CHECK THE AVAILABILITY OF MEETING ATIENDEES

• To INVITE PEOPLE AND RESOURCES TO A MEETING

1 ClIck. the Planner tab
2 ClIck InvIte
3 Under Show Names From The, select the lIst you want
4 ClIck the name you want to mVIte
5 ClIck ReqUIred or OptIOnal
6 ClIck Resource to add a resource such as a meetmg room
7 ClIck OK
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1 ClIck the Planner tab
2 Use the followmg procedures to check mformatIOn on the avaIlabIlIty of

meetmg attendees

TIp
When schedulmg meetmgs for a large group, you may find few or no open slots,
though you can determme WhICh tIme slots are the least busy One techmque IS to
send the meetmg request even If some attendees are already booked and ask those
who are booked to cancel or reschedule theIr other appomtments You can also
expedIte your plannmg by askmg for then best alternatIve meetmg tImes If they
cannot make the proposed tIme

5 Select the tIme slot you want, and then choose Request Meetmg
You can also clIck Auto PIck under the Tools menu Schedule+ wIll then find the
first tIme slot when all attendees are aVaIlable to meet

6 In the Subject box of the Meetmg Request form, type a descnptIOn of the meetmg
The descnptIOn WIll appear on your schedule

7 Add message text, such as a meetmg agenda, or attach files as appropnate, Just as
you do when sendmg an e-maIl message

8 ClIck the Send button
Schedule+ automatIcally marks the meetmg tIme m your Planner and places the
meetmg m your Appomtment Book

To check Do thIS
The names of unaVaIlable attendees for a Double clIck the busy tIme slot
tIme slot
A descnptIOn of the confhctmg Double clIck the busy tIme slot, and then
appomtment (only aVaIlable If you have clIck the name of the person or resource for
read permIsSIOn for the attendee's schedule) whIch you want detaIls

The aVaIlabIlIty of one person or resource In the Attendees lIst, double clIck the name
of a person or resource

The aVaIlabIlIty of a group, such as all the In the Attendees lIst, double chck the
Reqmred attendees Reqmred, OptIOnal, or Resource headmg
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1 ClIck the Planner tab
2 HIghlIght the earlIest tIme slot from whIch you want to begm searchIng for

an avaIlable meetIng tIme Schedule+ moves forward from that tIme slot to
find an avaIlable meetIng tIme

3 On the Tools menu, clIck Auto PIck
4 To use the suggested tIme to schedule the meetIng, clIck Request MeetIng
- Or-
To have Schedule+ look for the next aVailable tIme, clIck Auto PIck agaIn on the
Tools menu

You can also clIck the Insert New Contact button on the toolbar

• To ADD A CONTACT TO YOUR CONTACTS LIST

You can also clIck the Send button on the toolbar

-~
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Type the InfOrmatIOn for the contact You can move to the ne\.t area by
preSSIng TAB

2 Under Phone Number, select the type ofphone number and then type the
number In the box

3 ClIck the Phone, Address, or Notes tab to add any other InfOrmatIOn
4 ClIck OK

1 ClIck the Contacts tab
2 On the Insert menu, clIck Contact

1 ClIck the DaIly tab
2 Double-clIck the meetmg
3 ClIck the Attendees tab
4 ClIck OK

• To TRACK RESPONSES TO YOUR MEETING REQUEST

• To SEND A MEETING REQUEST

Application User GUide

• To SELECT A MEETING TIME YOURSELF

1 On the Planner tab, clIck Request Meetmg
2 In the Subject box, type a descnptIOn of the meetmg
3 Add any other reCIpIents, type any text, or attach any files that you want
4 To send the message, clIck Send on the FIle menu

1 ClIck the Planner tab
2 HIghlIght the tIme slot you want for the meetIng
3 ClIck Request MeetIng

To have Schedule+ select an aVailable meetIng tIme

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I



PosItIOn your mouse pomter over the button that you want mformatIOn about
Schedule+ dIsplays a ToolTIp that bnefly descnbes that button

Application User GUIde

You can also clIck the Delete button on the toolbar

• To SET THE REMINDER TIME FOR NEW APPOINTMENTS OR TASKS
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• To GET TOOLBAR BUTTON INFORMATION

1 ClIck the meetmg
2 On the EdIt menu, clIck Delete Item

• To CANCEL A MEETING

1 ClIck the Daily tab
2 Double-clIck the meetmg
3 On the General tab, change the tIme or date for the meetmg
4 ClIckOK

• To RESCHEDULE A MEETING

1 On the Tools menu, clIck OptIOns
2 ClIck the Defaults tab
3 If necessary, select the check box you want to automatIcally set remmders

for appomtments or tasks
4 To change the remmder tIme, clIck the arrows to select the number you

want
5 ClIck the down arrow to specIfy mmutes, hours, days, weeks, or months
6 ChckOK
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Room No ~prkgroup Occupants User Ext,. - - <
- "'" ... ,- • Name- -~ - , - ,

01 Project Office Mrs Nadia Ma!=jdy Nma!=jdy 15
02 Court Admin Mrs ShamNoor Abdul AZIZ Snoor 13

Mr Alber Szal Aszal 14
03 Court Auto Mr Walter Kuencer Wkuencer 11

Mr Shenf Hosnl Shosnl 12
04 Mr Gamal Kamel Gkamel 27
05 Judicial Train Mr Samlr Sultan Ssultan 28

Mrs VIrginia LeaVitt Vleavltt 29
06 PhotocoPYing 31
07 MOJ Coordinator Dr Ashraf Kamal Akamal 25
08 Conference Room 22
09 Prolect Office Mrs Janie Abdul AZlz Jabdulazlz 20
10 COP Mr Ronald Taylor Rtaylor 19

Reception Project Office Ms Mona Rashwan Mrashwan 10

Appendices

ApPENDIX A

The following Room Numbers I Extension Numbers used In the office
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A number of software products IS available for the AOJS members to use The
list Includes the followIng resources

Appendices

AVAILABLE SOFTWARE RESOURCES

Software Product Name - Quantity Available
ABC Flowcharter v 6 0 1
CorelWP v 7 0 1
Excel v 70 1
MS Exchange Win NT 1
MS Office Pro (Arabic) 2
MS Office (Arabic) 3
MS Office Pro v 97 (EnQllsh) 8
MS Publisher v 4 0 1
Norton AntIVIrus v 2 0 14
Norton Navigator Win95 1
Norton NT Tools v 1 0 1
Norton PC AnyWhere Win95 2
Norton Utilities v 2 0 1
OmnlPage Pro v 7 0 1
Organizer 97 10
PowerChute V 40 1
Prolect 5 5
VISI~ 1
Win'dows 95 (Pre-Installed) 14
Windows 95 (Arabic) 5
Windows NT Server 4 0 1
Windows NT Workstation 4 0 2
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USER SPECIFICATION SECTION
All workstations have Microsoft Exchange, Microsoft Schedule+, and Norton
AntiVirus

AppendIces

Item "" , SerraI Number-
MS Windows 95 22296-0EM-0014081-42932
MS Office 97 V'111)lsh 53491-806-1720121-00878
Lotus Organizer 1FOO022-72653190
Microsoft Prolect 35910-271-0108426-68621

Item - - Senal Number<

IBM System Unit 23PVX14
IBM MOnitor 23GK807
IBM Keyboard 0152960
IBM Mouse 139304
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User Name RTaylor
Workgroup COP

Workstation Hardware

Workstation Software
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Item I ? "- - SerraI Number
MS Windows 95 19796-0EM-0013395-88168
MS Office 97 Ci?ff f I::' h 53491-806-1716776-65132
Lotus OrQanlzer 1FOOO22-72653190

Item ,. - Serral Number-(
#

IBM System Unit
IBM Momtor 23X5630
IBM Keyboard 0198211
IBM Mouse 206215
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User Name WKuencer
Workgroup Court Auto

WorkstatIon Hardware

Workstation Software
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Item Senal Number
MS Windows 95 22296-0EM-0014081-71903
MS Office 97 t,\q ('Sh 53491-806-1770724-29250
Lotus Organizer 1FOO022-72653190
Microsoft Prolect 3590-056-0130962-55974

Item - Senal Number~

IBM System Unit 23PVZ38
IBM MOnitor 23GK390
IBM Keyboard 198209
IBM Mouse 206247
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User Name VLeavltt
Workgroup Judicial Tram

Workstation Hardware

Workstation Software
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Item Serial Number -- .
MS Windows 95 22296-0EM-0014081-88184
MS Office 97 6'n~ ItS}, 53491-806-1720623-71266
Lotus Organrzer 1F00022-72653190
Microsoft Project 35910-055-0920881-77792

Item -, Senal Number
IBM System Umt 23PWC31
IBM Momtor 23GN693
IBM Keyboard 0198275
IBM Mouse 206243
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User Name Jabdulazlz
Workgroup Project Office

Workstation Hardware

Workstation Software
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Item . -
( Senal Number

MS Windows 95 24264-425-0032952-62293
MS Office 95 Aroh/c.. 40644-425-0004917-33400
Lotus OrQanrzer 1FOO022-72653190

Item , Serial Number"
IBM System Unrt 23PVY52
IBM MOnitor 23GN680
IBM Keyboard 285417
IBM Mouse 999595
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User Name SSultan
Workgroup Judicial Tram

Workstation Hardware

Workstation Software
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Item Serial Number
MS Windows 95 24264-424-8014251-22808
MS Office 95 -A-ft::tbt'c... 40644-425-0004971-77863
Lotus Organizer 1F00022-72653190

Item. - ~ r Serial Number
IBM System Umt 23PVL94
IBM Monrtor 23GK396
IBM Keyboard 97020
IBM Mouse 932180
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User Name Snoor
Workgroup Court Admin

Workstation Hardware

Workstation Software
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User Name GKamel
Workgroup Project Office

Workstation Hardware

Item ~ Senal Number
IBM System Unrt 23PVZ884
IBM Monrtor 23GN761
IBM Keyboard 93423
IBM Mouse 39229

Workstation Software

Item Senal Number
MS Windows 95 22296-0EM-0014081-88363
Excel 33611-060-0103584-84785
Lotus Organrzer 1FOO022-72653190
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Item Serial Number -
MS Windows 95 24261-425-0032952-57466
MS Office 97 Amble- 40648-425-0026625-54661
Lotus OrQanlzer 1FOO022-72653190

Item - Serial Number
IBM System Unit 23PVY55
IBM Monrtor 23X5596
IBM Keyboard 198210
IBM Mouse 206217
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User Name SHosnI
Workgroup Court Auto

Workstation Hardware

Workstation Software
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Item· 1 - Serial Number
MS Windows 95 24261-442-1918324-11375
MS Office 95 .41'0 J,., I e.- 39043-071-0100204-70860
Lotus Organrzer 1F00022-72653190

Item ~ - ,
Serial Number-~ -

IBM System Unrt 23PVY17
IBM Monrtor 23GN719
IBM Keyboard 0159823
IBM Mouse 206281
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User Name NShaheen
Workgroup Project Office

Workstation Hardware

Workstation Software
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Item Senal Number
MS Windows 95 24264-425-0032952-98710
MS Office 95 A..rC.Vl c.. 40648-425-0026625-02635
Lotus OrQanlzer 1FOO022-72653190

Item r - Senal Number
IBM System Unit 23PV215
IBM MOnitor 23GN813
IBM Keyboard 0198205
IBM Mouse 931366
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User Name MRashwan
Workgroup Project Office

Workstation Hardware

Workstation Software
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Item Senal Number
MS Windows 95 22296-0EM-0014081-3331
MS Office 95Z-~l.s 1. 53491-806-1720614-80876
Lotus On:Janizer 1FOO022-72653190

Item " Senal Number- .- . .

IBM System Unit 23PVM59
IBM MOnitor 23GN765
IBM Keyboard 0092051
IBM Mouse 931457
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User Name ASzahl
Workgroup Court Admin

Workstation Hardware

Workstation Software
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Appendices

SERVER SPECIFICATIONS SECTION

1 processor 200 MHz Pro
64 MB RAM
2*2 1 GB SCSI hard disk dnve
1 4435" floppy disk drive
2/8 GB backup tape 4 mm OAT SCSI
6x SCSI CD ROM Dnve
Compaq Ethernet Network Card 10/100
MOnitor 15"
Keyboard
Compaq Mouse
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